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Introduction to upgrading victor and VideoEdge

To avail of the latest features, functions, and security enhancements, update your victor and
VideoEdge software to the most recent version. Use the Upgrade Options Guide to determine
supported update paths, update procedures, and for compatibility matrices.

Update strategy
To ensure a successful software update for your victor Network Video Management System, update
its components in the following order:
1. Update the victor Application Server or victor Site Manager software.
2. Update the victor Client or victor Unified Client software.
3. Update the victor Integration Driver software.
4. Update the VideoEdge NVR software.

Note:
- In version 4.5, the victor Site Manager was renamed the victor Application Server.
- Before you update victor Application Server, victor Client, or victor Unified Client,

ensure that Windows is up to date, with no updates pending.
- Intrusion integration drivers are available only on victor installation media. They are not

available from the installer dashboard.

Note: For information about victor Application Server and victor Unified Client software
updates, see victor update options. For information about victor Integration Drivers, see
Update options for victor Integration Drivers. For information about VideoEdge software
updates, see VideoEdge update options.

Downloading software updates
You can download software update packages from the American Dynamics website. Each software
package contains different combinations of software applications. Before you download a software
package, confirm that it contains the software applications that you want to install or update.
The following table lists the installation packages that you can use to install the victor Application
Server, victor Client or victor Unified Client, and victor Web.

Note: Update package contents can vary for different software releases. Before you download
a software update package, confirm that it contains the software that you want to update.

Table 1: Supported software update packages
Action Unified victor

Application
Server and SQL
Server

victor Client only victor web

Update the victor
Application Server

Yes Yes Yes No

Update victor
Client

Yes Yes Yes No

Update victor Web Yes Yes No
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Each of the supported installation packages contains a different installer:
• The Unified installation package contains the victor and C•CURE 9000 installer.
• The victor Application Server and SQL Server installation package contains the victor installer.
• The victor Web installation package contains the victor Web installer.

victor Upgrade options
Each victor installation is unique. Relationships and dependencies between various elements of the
system often require specific configuration and implementation sequences. Before you install or
update any victor software, plan and design your software deployment. Contact your AD Integrator
or Installer to adapt the details and sequence of your implementation to suit your needs.

Note: For update options from versions earlier than 5.0, refer to previous versions of this
document.

Note: If you update your software to a major release version, you must purchase a new
license.

Unified and non-Unified releases

  Attention

If you have a unified system, you cannot update to a non-unified version of victor Unified Client
or the victor Application server.
To update a Unified victor and C•CURE installation, use the latest version of the victor and C•CURE 9000
installer, available from the American Dynamics or Software House website. For C•CURE and Unified
customers, contact your support channel.
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System requirements

Before you perform a software update, verify that your current system meets or exceeds the
system requirements for the newer software version. Refer to the latest product datasheet for
product specifications.

Operating systems and databases
Note: From version 5.1 onwards, you cannot install victor on 32-bit operating systems. In
addition, you cannot upgrade victor to version 5.1+ on a 32-bit operating system

Operating systems that are supported in victor 6.0
Table 2: Operating systems that are supported in victor 6.0
Operating system Standalone SSA MAS
Win 11 64-bit 64-bit X
Win 10 (Pro/Ent)]

Note: Win 10
must be v1809 or
higher.

64-bit 64-bit X

Win Server 2016 (Std/
ent)

64-bit 64-bit 64-bit

Win Server 2019 (Std/
Ent)

64-bit 64-bit 64-bit
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Table 3: Databases that are supported in victor 6.1
Database Standalone SAS MAS
SQL Server 2016
(Express)

64-bit 64-bit X

SQL Server 2016 (Std/
Ent)

64-bit 64-bit 64-bit

SQL Server 2017
(Express)

64-bit 64-bit X

SQL Server 2019
(Express)

64-bit 64-bit X

SQL Server 2019 (Std/
Ent)

64-bit 64-bit 64-bit

Important: victor 6.1 is not a full software release. Treat the 6.1 release as a service pack only.
Install victor 6.0 before upgrading to 6.1.

Supported update paths
victor Application Server
To ensure a successful update, use the following supported update paths for victor Application
Server. This section provides information about the following victor Application Server
configurations:
• Standalone (victor only)
• Unified victor and C•CURE
• Enterprise MAS/SAS
• Centralized licensing for Standalone, Unified, or Enterprise SAS

Note: Before you start the update process, verify that the current victor Application Server
system meets or exceeds the system requirements for the newer software version. Refer to
the latest datasheet for product specifications.

Update paths for victor Application Server: Standalone (victor only)
The following table shows the supported one-step update paths for victor Application Server.
The table lists the software updates that are compatible with the current version of your victor
Application Server software. To update to the latest version of the victor Application Server, use the
most direct update path.
Table 4: Direct one-step software update paths for victor Application Server 5.0 to 6.1
Current
version

Upgrade
to 5.1

Upgrade
to 5.2

Upgrade
to 5.3

Upgrade
to 5.4

Upgrade
to 5.4.1

Upgrade
to 5.6

Upgrade
to 5.7

Upgrade
to 5.9

Upgrade
to 6.0

Upgrade
to 6.1

5.0 Yes Yes
5.1 Yes Yes
5.2 Yes Yes Yes
5.3 Yes Yes Yes
5.4 Yes Yes Yes
5.4.1 Yes Yes Yes
5.6 Yes Yes Yes
5.7 Yes Yes
5.9 Yes
6.0 Yes
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Update steps for victor Application Server
1. Verify the SSA status:

On the victor Application Server host, launch License Manager to check SSA status. If expired,
contact tspssa@tycoint.com to purchase SSA before updating.

WARNING: if your SSA expires, you are not entitled to any free software updates, liense
updates or support. You must purhase a license to continue using victor

2. Back up the database:
Back up the current victor Application Server database configuration before you update any
software.

3. Check the Integration compatibility:
Always check the website to verify that any required integrations are compatible with
your current victor version. If not, then it is recommended to postpone the update until
the required integration becomes available to ensure forward compatibility with existing
configurations.

4. Update the software:
Install the software update for victor Professional (victor Application Server).

5. Update the license
Go to www.americandynamics.net and navigate to the Register a Product page to register for
the updated victor license file, choosing the same version as the Software Update.

Upgrade paths for victor Application Server:
Unified victor and C•CURE
The following figures outline the supported update paths for a Unified victor Application Server.

There are four update options for a Unified Server. Some update options are not available for each
Unified Server:
• New Host: Select this option to install a new victor and C•CURE Unified server.
• C•CURE Host: Select this option to upgrade a C•CURE system to a victor and C•CURE Unified

server.
• Unified Host: Select this option to perform a software update for a victor and C•CURE Unified

server.
• C•CURE Host and victor Host: Select this option to merge a C•CURE installation with a victor

installation to create a victor and C•CURE Unified server.

Note: The following versions of victor are standalone versions that are not compatible with
Unified software updates:
• victor 5.7
• victor 5.9
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Unified Server 5.0 / 2.61

Unified Server 5.1 / 2.61

Unified Server 5.2 / 2.70
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Unified Server 5.4.1 / 2.80

Unified Server 5.6 / 2.90

Unified Server 6.0 / 3.0
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Update steps for victor Application Server (Unified victor/
C•CURE

1. Check SSA status:
On the victor Application Server host, launch License Manager to check SSA status. If expired,
to purchase SSA before updating, contact tspssa@tycoint.com.

WARNING: If your SSA expires, you are not entitled to any free software updates, license
updates, or support. You must purchase a license to continue using victor.

2. Back up the Database:
Back up the current victor Application Server database configuration before you update any
software.

3. Check the integrations:
Always check the web site to verify that any required integrations are compatible with
your current victor version. If not, then it is recommended to postpone the update until
the required integration becomes available to ensure forward compatibility with existing
configurations.

4. Update the software:
Use one of the update options to install the Unified Server software.

5. Update the license
- Go to www.swhouse.com and navigate to the Register a Product page to register for the

updated C•CURE 9000 license file.
- Go to www.americandynamics.net and navigate to the Register a Product page to register

for the updated victor license file, same version as software update.

Note:
- Verify that the required license add-on option for Unified is ordered for your system

license, for example, ADVCCC9000.
- This add-on enables the C•CURE and victor installers to support installation onto the

same common host to create the Unified victor and C•CURE solution.
- Verify that the current victor Application Server system meets or exceeds the system

requirements for the newer
- Unified victor and C•CURE software versions. Refer to the latest datasheet or user

manual for details.
- The victor Application Server system is designed to utilize the relational database,

both Microsoft SQL Express and Server. When you update your victor server, it also
updates the relation database.

Upgrade paths for victor Application Server:
Enterprise MAS/SAS

Note:

You cannot update a unified MAS or SAS to a non-unified version. The following versions of
victor are standalone versions that are not compatible with Unified software updates:
• victor 5.3
• victor 5.4
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• victor 5.7
• victor 5.9

Table 5: Direct one-step software upgrade paths for victor Application Server Enterprise MAS/
SAS
Current
version

Upgrade
to 5.1

Upgrade
to 5.2

Upgrade
to 5.3

Upgrade
to 5.4

Upgrade
to 5.4.1

Upgrade
to 5.6

Upgrade
to 5.7

Upgrade
to 5.9

Upgrade
to 6.0

Upgrade
to 6.1

5.0 Yes Yes
5.1 Yes Yes
5.2 Yes Yes Yes
5.3 Yes Yes Yes
5.4 Yes Yes Yes
5.4.1 Yes Yes Yes
5.6 Yes Yes Yes
5.7 Yes Yes
5.9 Yes
6.0 Yes

Update steps for victor Application Server (Enterprise MAS/
SAS)

1. Verify the SSA status:
On the victor Application Server host, launch License Manager to check SSA status. If expired,
then contact tspssa@tycoint.com to purchase SSA before updating.

WARNING: If your SSA expires, then you are not entitled to any free software updates,
license updates, or support. You must purchase a license to continue using victor.

2. Back up the database:
Back up the current victor Application Server database configuration before you update any
software.

3. Update the software:
Install the software update for victor Application Server(Enterprise MAS/SAS).

4. Update the license:
Go to www.americandynamics.net and navigate to the Register A Product page to register for
the updated victor license file, same version as Software Update.

Note: You cannot promote a standalone victor Application Server to a Master
Application Server (MAS). To promote a standalone victor Application server to a Satellite
Application Server (SAS), your system must meet the following criteria:
- Your system must have a MAS and it must not already exceed the current 40 SAS

management limitation.
- The victor Application Server must meet the SAS system requirements.
- You must purchase the required victor add-on license option, ADVC-APPSERVER,

before you promote a Standalone victor Application Server to a SAS.
Verify that the version of victor Application Server Enterprise SAS is the same version as
the Enterprise MAS.

Verify that the current victor Application Server Enterprise MAS/SAS system meets or
exceeds the system requirements for the newer software version. Refer to the latest
datasheet or user manual for details.
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Update paths for centralized licensing: Standalone, Unified,
or Entreprise SAS

Example:  
Centralized licensing is supported from victor version 4.9 onwards. See the relevant update
table for your victor Application Server type.

victor Express after 5.7.1
Note: victor Express is not supported in versions 5.7.1 or higher.

Update paths for victor Client and victor Unified
Client
To ensure a successful update, use the following supported update paths for victor Unified Client.

Table 6: Direct one-step software update options for victor Unified Client
Current version Compatible one-step software updates
5.0 Version 5.1 or higher
5.1 Version 5.2 or higher
5.2 Version 5.3 or higher
5.3 Version 5.4 or higher
5.4 Version 5.4.1 or higher
5.4.1 Version 5.6 or higher
5.6 Version 5.7 or higher
5.7 Version 5.9 or higher
5.9 Version 6.0 or higher
6.0 Version 6.1 or higher

The following versions of victor are standalone versions that are not compatible with Unified
software updates:
• victor 5.3
• victor 5.4
• victor 5.7
• victor 5.9

Update steps for victor Unified Client
1. Verify the SSA status: There is no SSA for victor Unified Client. This is only applicable to victor

Express, victor Professional or victor Enterprise.
2. Back up the database: There is no need to back up the database for victor Unified Client. This

is only applicable to victor Express, victor Professional, or victor Enterprise.
3. Updare the software: Install the software update for victor Unified Client.

WARNING:
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It is recommended that the victor Unified Clients are running the same or no more than
two versions lower than the victor Application Server version to ensure compatibility.

4. Update the license:
No license is required for victor Unified Client. This is only applicable to victor Express or
victor Professional, or victor Enterprise.

Upgrade paths for victor Web Client
To ensure a successful upgrade, use the following supported upgrade paths for victor Web Client.

Table 7: Direct one-step software upgrade paths for victor Web Client
Current
version

Upgrad
e to 5.1

Upgrad
e to 5.2

Upgrad
e to 5.3

Upgrad
e to 5.4

Upgrad
e to
5.4.1

Upgrad
e to 5.6

Upgrad
e to 5.7

Upgrad
e to 5.9

Upgrad
e to 6.0

5.0 Yes Yes
5.1 Yes Yes
5.2 Yes Yes Yes
5.3 Yes Yes Yes
5.4 Yes Yes Yes
5.4.1 Yes Yes Yes
5.6 Yes Yes Yes
5.7 Yes Yes
5.9 Yes

Tip: victor Web Client is a purchased product that requires licensing:
• victor Web Client requires purchasing the victor add-on license option victor Web Service

(ADVCWEBSERVICE) and installing it on the victor Application Server host.
• If you install victor Web Client on the victor Application Server, you can include victor Web

Client license components in the victor Application Server license. Register for an updated
victor Application Server license file that includes the add-on options for victor Web Client.

• If you install victor Web Client on a standalone server, you need a separate license for
victor Web Client. The victor Web Client license is separate from the victor Application
Server license. Order the victor Web Client base-model (ADVWCC01) plus any required add-
ons to receive a new software serial number that is used for registering for a victor Web
Client license file.

Note: victor Web Client must be the same version as the victor Application Server. For
example, victor Web Client version 6.0 requires victor Application Server version 6.0. Before
you start the update process, verify that the current victor Web Client system meets or exceeds
the system requirements for the newer software version. Refer to the latest datasheet for
product specifications. Refer to victor Web Service 4.00/6.1 victor Web Client Critical Update 01
Release note and victor 6.1 and Unified 4.00 Service Pack 1 Release Note. Also see Updating victor
Web Client

Updating victor Web Client
About this task:  
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In victor Web 5.4, you must configure victor Application Server integration when you install victor
Web. If you update victor Web to version 5.4, during the update process you must enter or re-enter
victor Application Server configuration information.

When updating victor Web Client to 6.1, use:
WebClient_v3.00Update01.exe

Refer to the victor 6.1 and Unified 4.00 Service Pack 1 Release Note and the victor Web Service 4.00/6.1
victor Web Client Critical Update 01 Release note.

Important: before you install the victor WebClient 4.00/6.0 critical update ensure the target
machine runs victor Web version 6.0.

1. Verify the SSA:
On the victor Web Client host, launch License Manager to check SSA status. If expired, contact
tspssa@tycoint.com to purchase SSA before updating.

WARNING: If your SSA expires, you are not entitled to any free software updates, license
updates, or support.

2. Backup the database:
No backup database is required for victor Web Client, database backup is only applicable to
victor Express, victor Professional, or victor Enterprise.

3. Update the software:
Install the software update for victor Web Client:

WARNING: To ensure compatibility, both victor Web and victor Application Server must
be running the same versions.

4. Update the license:
Go to www.americandynamics.net and navigate to the Register A Product page to register
for the updated victor Web license file, same version as Software Update.

Upgrading victor Application Server and victor
Client
The following section contains the procedure for updating victor Application Server and victor Client
to version 5.4 or higher. You can update all eligible components as part of the same process.

You can use the victor and C•CURE 9000 installer or the victor installer to update victor Application
Server and victor Client. If your system is a unified system, then you must use the victor and C•CURE
9000 installer to update victor Application Server and victor Unified Client.

Updating software integrations
When you update victor Client or the victor Application Server, you must also update any
integrations that are installed on your system. Ensure that you have all of the required installers
before you begin the update process.
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  CAUTION

From victor 5.4 onwards, integrations that use the victor Web Service must have a unique
identifier. Integrations that do not have this identifier are not compatible with victor 5.4. If you
have any integrations installed on your victor Application Server, verify that they are compatible
with victor 5.4 before you perform a software update.
You can check integration compatibility from the American Dynamics partners portal. Visit the American
Dynamics website, from the top navigation bar, select Partners and Compatibility Matrix.

Updating SQL
If you are updating your system and your standalone system has SQL 2014, the dashboard
automatically upgrades your databases to SQL 2019. To use the auto upgrade feature, your system
must meet the following conditions:
• SQL 2014 Express is installed on your system
• Standalone victor Application Server installation
• Default SQL instance name
• Default installation location

Note: If you have SQL Server 2014 SP2 installed on your standalone system, it will not upgrade
to SQL 2019, as victor still supports SQL Server 2014 SP2.

Updating a localized version of victor
If you use victor in a non-English language, you must also install the Unified Language Pack
when you update victor. The Unified Language pack is included in the victor and C•CURE Unified
installation package. If you use a different pack to update victor, you must install the Unified
Language pack separately. For non-unified versions of victor, you must install the Language
pack separately. You can download the Language Pack and the Unified Language Pack from the
American Dynamics website.

Upgrading victor Application Server and victor
Unified Client to version 5.4+

1. Close any programs that are currently running.
2. Start the installer.

When you run the installer, you may be prompted to install Microsoft .NET 4.6.1. Follow
the on-screen instructions, and restart your computer if required. After the restart, run the
installer to continue the update process.

3. On the installer dashboard, select Advanced.
4. Optional: Select the check boxes for any other components that you want to install or update,

and click Next.
5. If required, edit the credentials in the victor Application Server Configuration and victor Web

Service API fields.
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6. When victor Web Client is present, update the victor Web configuration information:Set the
Protocol to HTTP or HTTPS.
a. Do not use this operator account to log on to victor Web.

Note: If you select HTTPS, you must configure SSL after you install victor Application
Server.

b. Note: Do not use this operator account to log on to victor Web.
In the Web Client Operator Account section, configure the victor Application Server
operator account that victor Web uses to communicate with the victor Application Server.

i. In the Operator Username field, enter the operator user name.
ii. In the Operator Password field, enter the operator password.
iii. In the victor Web Service Host field, enter the address of the victor Web Service.

c. In the Web Client Administration Account section, configure the default administrator
account for victor Web.

Note: The default administrator account is only associated with victor Web. Use
the default administrator account to configure or edit victor Application Server
integration settings. After you integrate the web client with the victor Application
Server, you can use victor Application Server operator credentials to log into victor
Web.

i. In the Administrator Username field, enter an administrator user name.
ii. In the Administrator Password field, enter an administrator password.
iii. In the Re-enter Password field, re-enter the password, and click Next.

7. Click Next.
8. Review the list of components to be updated, and select Upgrade.
9. Read the End User License Agreement (EULA), and to start the update, click I Agree.
10. Complete the update:

- If there are integrations installed on your system, select Later. You must update all
integrations before you restart your computer.

- If integrations are not installed on your system, select Reboot to restart your computer
immediately.

Upgrades to version 5.0 to 5.3

About this task:  

1. Close any programs that are currently running.
2. Start the installer.

Note: When you run the installer, you may be prompted to install Microsoft .NET 4.6.1.
Follow the on-screen instructions, and restart your computer if required. After the
restart, run the installer to continue the update process.
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3. Optional: To
configure additional update settings, complete the following steps:
a. Click Advanced.
b. Select the check boxes of any additional components that you require, and click Next
c. If required, edit the credentials in the victor Application Server Configuration and victor

Web Service API fields, and click Next.
4. Review the list of components to be updated, and select Upgrade.
5. Read the End User License Agreement (EULA), and to start the update, click I Agree
6. Complete the update.

- If there are integrations installed on your system, click Later. You must update all
integrations before you restart your computer.

- If integrations are not installed on your system, click Reboot to restart your computer
immediately.

Upgrading victor Application Server
Before you begin:  

CAUTION: Ensure that you read and understand all of the following instructions before you
update victor Application Server. If you have any difficulties or questions, contact your dealer
or American Dynamics Technical Support.

• Ensure that your user account has administrator privileges before you begin the update.
• When you perform software updates, use the same operating system administrator account

that you use for the initial installation.
• Verify that the Software Services Agreement (SSA) is still valid before updating victor to ensure

that you can successfully register online to receive the required updated license file.
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About this task:  

1. Close any programs that are currently running.

Note: When you run the installer, you can be prompted to install a version of
Microsoft .NET. Follow the on-screen instructions, and restart your computer if required.
After the restart, run the installer to continue the update process.

2. In the brands tile, select American Dynamics and click Next.
3. From the Platforms tile, select victor Application Server and Client.
4. Click Next. The Install Items and Install Types window displays. If prerequisites are required,

they are listed above with the victor Application Server and victor unified client.
5. Read the End User License Agreement (EULA) carefully, select the EULA check box, and click

Next.
6. Navigate through the installation properties page until the Ready to Install window displays.

Review the items that are listed for update, and click Install.
7. In the Prerequisites window, review the update prerequisites, and to begin the update, click

Install.

Note:
- A progress bar tracks the install and update process.• victor services are stopped

during the victor Application Server and victor unified client update.
- When the update completes, the Installation Complete window appears.
- After you update victor Application Server and victor Client, you must restart your

system.

Updating a victor license: Application Server
To update the victor license for the application server complete this task.

1. Launch the License Manager program and click Generate System Information.
2. Save the License Manager-generated XML file to your local hard drive or USB stick.
3. Locate the unique victor software serial number (ESSxxxxxxxxxxxx)

For example, the label on the victor DVD or part of the license file name :
C:\Program Files (x86)\Tyco\Crossfire\License\

4. On an Internet browser, go to the American Dynamics web site: http://
www.americandynamics.net.

5. Navigate to Products &gt; Register Software Licensing, and click victor Software.
6. In the Brand list, ensure that American Dynamics is selected.
7. From the Product list, select Victor.
8. In the Personal Data Processing Consent window, select I consent and confirm.
9. Complete the American Dynamics victor - Online Software Registration Form.

Note: Ensure that you select Update Existing License in the Registration Type area.

10. Click Submit.
11. If the form entries are valid, an auto-generated license email is sent to your email address.
12. Save the compatible license file to your local hard drive or USB stick.
13. From the License Manager program, select Add New License.
14. If required, manually stop and start the CrossFire services or restart the victor host machine.
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15. Confirm that the license is accepted:
- Check the status in the License Manager.
- On the victor Application Server, in the Server Configuration application, check the status

of Services.

Note: For more detailed information, refer to the licensing documentation included in
the email with your license.

victor integration drivers

Before you begin:  
When you update victor or the victor Application Server, you must also update any integrations that
are installed on your system. After you complete a victor Application Server installation, the installer
prompts you to restart your computer. You must update all integrations before you restart your
computer.

Ensure that you have all required installers before you begin the update process. Always check
the American Dynamics website to verify that the update version also supports any required
integrations used with your current victor version. If not, then it is recommended to postpone
the update until the required integration becomes available to ensure forward compatibility with
existing configurations.

CAUTION: From victor 5.4 onwards, integrations that use the victor Web Service must have a
unique identifier. Integrations that do not have this identifier are not compatible with victor
5.4. If you have any integrations installed on your victor Application Server, verify that they are
compatible with victor 5.4 before you perform a software update. You can check integration
compatibility from the American Dynamics partners portal. Go to the American Dynamics
website, select Partners from the top navigation bar, and then click Compatibility Matrix.

About this task:  
Resynchronizing victor integration drivers

1. Click Start, Control Panel, and Programs and Features.
2. From the programs list, select the integration driver that you want to repair, and click Repair.
3. When the driver setup window opens, click Resynchronize or Repair.
4. When the process is complete, repeat this procedure for all other installed integration drivers.

VideoEdge Updater

You must update to VideoEdge 4.9 before you can update to subsequent versions. However, you
cannot install the VideoEdge 4.9 update through traditional methods, for example, through the
VideoEdge Administration Interface or through a VideoEdge Push Update package. Instead, you
must use the VideoEdge Updater to upload and install 4.9.0 updates to the VideoEdge device.
• After you update your VideoEdge to version 4.9.0, you can update to subsequent releases

through the VideoEdge Updater, through Push Updates, or through the Administration
Interface.

• To install the VideoEdge Updater, see Installing the VideoEdge Updater.
• To update to VideoEdge 4.9.0, see Updating the VideoEdge to version 4.9.0.
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• To update to VideoEdge 4.9+, see Updating the VideoEdge to version 4.9+

Installing the VideoEdge Updater

About this task:  

1. Launch the installer.
2. Select the I accept the terms in the License Agreement check box, and click Install.
3. If prompted, to allow the installer to make changes to the computer, click Yes
4. Optional: Select the Launch VideoEdge Updater check box.
5. To complete the installation, click Finish.

If you selected the Launch VideoEdge Updater check box, the VideoEdge Updater
launches.

6. To launch the VideoEdge Updater manually, complete the following steps:
a. To locate the VideoEdge Updater, on the Start menu, use the Search command.
b. From the search results, select the application.
c. You can also launch the VideoEdge Updater through Windows Explorer. The path of the

application can vary, depending on your operating system.
C:\Program files\Tyco\VideoEdgeUpdater or C:\Program files(x86)\Tyco
\VideoEdgeUpdater.

Updating VideoEdge
Use the VideoEdge Updater to update one Network Video Recorder or multiple Network Video
Recorders at the same time.

Before you begin:  
When you select an update package, the VideoEdge Updater calculates the package's checksum
value. If the calculation succeeds, a checkmark icon appears beside the Browse button. Hover over
the checkmark icon to view the calculated checksum value.

When you upload an update package to VideoEdge, the VideoEdge Updater compares the uploaded
package's checksum with the calculated checksum. The result appears in the status window.

Note: If the VideoEdge Updater cannot calculate an update package's checksum, you can still
upload the package to a VideoEdge. However, a warning displays.

Check the System requirements of your recorder from the Help menu in System Requirements. The
following software versions are supported by the 4.9.0 update path:
• 4.4.0.800
• 4.4.4.122
• 4.4.4.132
• 4.5 and later up to and including 4.8.1.

Note: You must update to version 4.9.0 before you can update to version 4.9.1 or higher.

The minimum system configuration required for 4.9.0 updates is:
• An existing clip export partition- Mounted on /dev/sdb1

- Accessed as /var/opt/americandynamics/venvr/clipexport
- Minimum size: 100GB
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- Current system disk mounted on /dev/sda:
- Minimum size: 100GB
- Only 3 partitions configured

You must know the VideoEdge Account Passwords and root Passwords for all the recorders that
you want to update.

If you are using a low-bandwidth network connection, you should perform an upload and install
separately. The Upload &amp; Install button is only recommended for users with high-bandwidth
network connections.

Note:  In previous VideoEdge releases the clip export partition may not have been configured
for victor client search and retrieve usage. It may have only been configured for VideoEdge
Client and C·CURE search and retrieve usage. Check your partitions set up before you update
VideoEdge. If your system does not meet the Clip Export criteria, consult the Troubleshooting
section of this document.

About this task:  
Use the VideoEdge Updater to update one recorder or multiple recorders at the same time. To
update multiple recorders simultaneously, each recorder must have the same VideoEdge Account
Password and root password. If any of the recorders have a VideoEdge Account Password or root
Password that is different to the credentials that you enter in the VideoEdge Updater, the update
will not start, due to a failed credential check. To resolve this issue, you can update VideoEdges with
different credentials in separate batches, or you can update all VideoEdges so that they use the
same VideoEdge Account Password and root Password.

You can change the VideoEdge Account Password through the YaST control panel, in the User and
Group Management menu. You can also change the VideoEdge Account Password and the root
password through the VideoEdge Administration Interface. From the System menu, select Security
Configuration, then select System Password. For more information, refer to the VideoEdge NVR
Installation and User Guide.

Note:
• The VideoEdge Updater is supported on 32-bit and 64-bit Windows operating systems.
• It is advised that you create a backup of your existing VideoEdge recorders before you

update them. You can back up your recorder through the Admin Interface. From the
System menu, select Backup/Restore.

• Any clips that you export or save from the local client to the sdb partition are deleted when
you update your VideoEdge.

• To save these clips, you should back them up to external storage before you update your
VideoEdge.You must have 100GB of disk space available on your VideoEdge.

• To access the VideoEdge Updater help, hover over the Help icon.

Updating VideoEdge to version 4.9.0

1. Launch the VideoEdge Updater.
2. To add a VideoEdge device, complete the following steps:

a. Click Add Recorder.
b. Enter the VideoEdge IP address.
c. To add the recorder, click Ok or press Enter.

3. Optional: To remove a VideoEdge device, select a VideoEdge IP address and click Delete
Recorder.

4. To enter the VideoEdge credentials, complete the following steps:
a. In the VideoEdge Account username field, enter a user name.
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b. In the VideoEdge Account password field, enter the password.
c. In the root Password field, enter the root password.

5. In the Base port field, enter the base port number. The default value is 22.

6. Note: The File Transfer Limit is the number of VideoEdges that the Updater can upload
to simultaneously. For example, if you add four recorders and set the file transfer limit to
two and click upload, it uploads two at time. After the update package is copied across to
one and two, it then copies it to three and four.

If you are upgrading multiple VideoEdges, in the File Transfer Limit field, enter a limit value.
The default value is 10.

7. Optional: To save the list of recorders in a configuration file, complete the following steps:
a. From the File menu, select Save as.
b. Navigate to the folder where you want to save the configuration file.
c. Optional: Edit the File name.
d. Click Save.
The following information is saved in the configuration file: VideoEdge IP address, VideoEdge
Account Username, Base port, and File Transfer limit.

8. Optional: To open a previously saved configuration file, complete the following steps:
a. From the File menu, click Open, and navigate to the configuration file.
b. Select the configuration file and click Open.

9. To verify that the VideoEdge IP address, VideoEdge Account Username, VideoEdge Account
Password, and root Password are correct, click Check Credentials.

10. Optional: To confirm the current version of the VideoEdge software, click Check Version.
11. To confirm that the VideoEdge meets the 4.9 update requirements, click Check 4.9 Upgrade

Compatibility.

Note: The following criteria are assessed when you check VideoEdge compatibility:
The following software versions are supported by the 4.9.0 update path: 4.4.0.800,
4.4.4.122 , 4.5 and later, up to and including 4.8.1. Root partition is configured on /dev/
sdb1 This only checks this is configured but not mounted (specified as /var/opt/
americandynamics/venvr/clipexport in /etc/fstab) The minimum size of clip
partition is 100GB. If /dev/sdb is of type msdos partitions, it cannot have any currently
configured extended partitions.

12. To select the VideoEdge Update Package, complete the following steps:
a. Click Browse.
b. From the Files of type list, select Upgrade RPM.
c. Navigate to the required file and click Open.

13. To update the VideoEdge, complete the following steps:
a. To transfer the update package to the VideoEdge, click Upload.
b. To confirm the upload, click OK.
c. When the upload is complete, to install the update on the VideoEdge, click Install.
d. To confirm the installation, click OK.
e. To delete exported clips and to begin the update, click OK.
OR
a. click Upload & Install

Note: The upload and install action in this step is only recommended for users with
high-bandwidth network connections.

b. To confirm the update, click OK
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c. To delete exported clips and to begin the update, click OK.
The update package uploads and automatically installs on the VideoEdge.

14. To verify that the installation succeeded, complete the following steps:
a. To confirm that the VideoEdge updated successfully, click Check Version.
b. To view VideoEdge storage information, click Storage Details.
c. To view the recording statistics, click Record Stats.
d. To view the video stream recording statistics, click Stream Stats
e. To display a snapshot from a camera that connects to the VideoEdge recorder, click

Snapshot, select a VideoEdge recorder, and select a camera.

Note: Snapshots are saved to the following directory:C:\users\username
\VideoEdgeUpdater\

15. To finalize the installation, complete the following steps:
a. Click Finalize 4.9 Install.
b. To complete the installation, click OK.

Updating the VideoEdge to version 4.9+ or 6.0+
About this task:  
After you update the VideoEdge to version 4.9 or to 5.7 you can update to subsequent releases
through the VideoEdge Updater, push updates, incremental updates, or the VideoEdge
Administration Interface.

1. Launch the VideoEdge Updater.
2. To add a VideoEdge device, complete the following steps:

a. Click Add Recorder.
b. Enter the VideoEdge IP address.
c. To add the recorder, click Ok or press Enter, or to cancel adding the recorder, click Cancel

or press Esc.
3. Optional: To remove a VideoEdge device, select a VideoEdge IP address, and click Delete

Recorder.
4. To enter the VideoEdge credentials, complete the following steps:

a. In the VideoEdge Account username field, enter a user name.
b. In the VideoEdge Account password field, enter the password.
c. In the root Password field, enter the root password.

5. In the Base port field, enter the base port number. The default value is 22.

6. Note: The File Transfer Limit is the number of VideoEdges that the Updater can upload
to simultaneously. For example, if you add four recorders and set the file transfer limit to
two and click upload, it uploads two at time. After the update package is copied across to
one and two, it then copies it to three and four.

If you are upgrading multiple VideoEdges, in the File Transfer Limit field, enter a limit value.
The default value is 10.

7. Note: In the configuration file, complete the following steps: VideoEdge IP address,
VideoEdge Account Username, Base port, and File Transfer limit.

Optional: To save the list of recorders in a configuration file, complete the following steps:

a. From the File menu, select Save as.
b. Navigate to the folder where you want to save the configuration file.
c. Optional: Edit the File name.
d. Click Save.
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8. Optional: To open a previously saved configuration file, complete the following steps:
a. From the File menu, click Open, and navigate to the configuration file.
b. Select the configuration file and click Open.

9. To verify that the VideoEdge IP address, VideoEdge Account Username, VideoEdge Account
Password, and root Password are correct, click Check Credentials.

10. Optional: To confirm the current version of the VideoEdge software, click Check Version.
11. To select the VideoEdge Update Package, click Browse and from the Files of type list, select

Upgrade ISO. Navigate to the required file and click Open.
12. To update the VideoEdge, complete the following steps:

a. To transfer the update package to the VideoEdge, click Upload.
b. To confirm the upload, click OK.
c. When the upload is complete, to install the update on the VideoEdge, click Install.
d. To confirm the installation, click OK.
e. To delete exported clips and to begin the update, click OK.

13. Alternatively
a. Note: The upload and install action is only recommended for users with high-

bandwidth network connections.
Click Upload & Install.

b. To confirm the update, click OK.
The update package uploads and automatically installs on the VideoEdge.

Troubleshooting
Some common customer concerns and FAQs about upgrading victor and VideoEdge

Interrupted installation
If the VideoEdge Updater installation is interrupted, the Setup Wizard displays a notification. Exit
and relaunch the Setup Wizard to reattempt the installation.

Logs
A log file is created for each recorder that you add to the VideoEdge Updater. Each VideoEdge’s log
file is named after the VideoEdge’s IP address.
When you perform any of the following functions, the information is saved to the status log file
for each recorder: Check Credentials, Check Version, Upload, Install, Upload &amp; Install, Finalize
Install, Storage Details, Record Stats, and Stream Stats. C:\User\username\VideoEdgeUpdater\logs

FAQ
Question: What happens if I enter an incorrect VideoEdge Account user name, VideoEdge Account
password, or root password?Answer: If you enter incorrect VideoEdge credentials, you receive an
error message when you click the Check Credentials button. The following examples show some of
the different error messages you can encounter when you check VideoEdge credentials
Question: What happens if my recorder does not meet the Clip Export criteria?Answer: If your
recorder does not meet any of the Clip Export criteria, it cannot be updated. Analyze your system to
check if you can edit the partitions to create a Clip Export partition on sdb1. For more information,
refer to the VideoEdge NVR Installation and User Guide.
Depending on the VideoEdge configuration, editing the sdb1 partition can result in the loss of
media. If you want to retain the media, there are two options:
Do not update to VideoEdge 4.9.
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Perform an OEM installation of VideoEdge 4.9 and keep the existing media. Selecting this option
has the following impact and risks:
Editing a partition can result in the loss of data and recorded video.
During an OEM installation, the VideoEdge is not accessible, and video footage is not recorded to
that VideoEdge.
You cannot use a backup of the configuration of a previous version of the recorder to restore after
the unit has been recovered.
When you add cameras to the recorder after an OEM installation, the cameras may not be assigned
to the same slots that they had before the update. This can cause video playback issues, because
the video footage is linked to the camera’s original slot instead of the camera. If cameras are
assigned to new slots, incorrect video or no video is returned during video playback.

Updating the VideoEdge through the Administration
Interface 4.2 to 4.5.1
About this task:  
For VideoEdge versions 4.2 to 4.5.1 select one of the following procedures:

1. From the VideoEdge Recorder or remote client PC, launch a web browser, enter the
VideoEdge IP Address and log on as an administrator.

2. From the main menu, click System and Update Software.
3. To select the compatible update package version, click Browse and Upload.
4. Select the compatible NVR_Update_Full.ISO package and click Install.
5. To reboot the VideoEdge NVR Recorder, click OK.

Updating the VideoEdge through the Administration
Interface in VideoEdge versions 4.6+

About this task:  
For VideoEdge versions 4.6+

1. From the VideoEdge Recorder or remote client PC, launch a web browser, enter the
VideoEdge IP Address, and use the softwareadmin user credentials to log on.

2. To select the compatible update package version, click Browse and Open.
3. Click Upload.
4. Select the compatible NVR_Update_Full-&lt;NVR Version&gt;.veos.x86_64.iso package and click

Install.

Note: The software update process interrupts recording and the VideoEdge
automatically reboots, as necessary.

5. After the VideoEdge reboots, select the uploaded package, and click Delete.
6. Select Logout, and to exit the Update Software page, click OK.
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Push updates:Updating the VideoEdge software through a
victor push update, victor 4.4 to victor 5.2

About this task:  
To install the update repository on the victor Application Server, complete the following steps:

1. To install the update repository on the victor Application Server, complete the following steps:
a. Log on to the victor Application Server computer.

You must log on to Windows with the same account that you used for the victor
installation.

b. Copy the Push Update Package onto the victor Application Server.
c. Double-click the update package and follow the on-screen instructions to install the

update repository.
2. Launch victor Client and connect to the victor Application Server that contains the push

update.
3. From the Devices list, right-click the VideoEdge Recorder, and click Check for Updates.
4. Select the supported update version, click Install and accept the EULA.

Note:
- The VideoEdge can reboot multiple times as part of the same upgrade action.
- The VideoEdge recorder reboots when the Push Update is complete.

Push updates: Updating the VideoEdge software through a
push update, victor 5.3 to victor 6.1

About this task:  

Note:
• Review the supported VideoEdge upgrade paths before you update your VideoEdge.
• If a recorder is eligible for a Push update and an Incremental update, you must use the

Incremental update.
• The Device Management page is not available in victor Express.

1. To install the update repository on the victor Application Server, complete the following steps:
a. Log on to the victor Application Server computer.

You must log on to Windows with the same account that you used for the victor
installation.

b. Copy the Push Update Package onto the victor Application Server.
c. Double-click the update package and follow the on-screen instructions to install the

update repository.
2. Log on to victor Client.
3. Click the Settings icon, and click Device Management.
4. To add recorders to the Recorder Firmware tab, complete the following steps:

a. Click the Recorder Firmware tab.
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b. Expand the Devices list and navigate to the recorders that you want to upgrade.
c. From the Devices list, drag the recorders into the Device Management window.

5. Select the recorders that you want to update.

Note: You cannot perform push updates and Incremental updates as part of the same
operation.You cannot update different recorders to different versions as part of the
same action.

6. Optional: Schedule the firmware upgrade:
a. Select the Schedule Firmware Upgrade check box.
b. In the Start field, enter the start date or to choose the start date, click the Calendar icon.
c. In the Start Time field, enter the start time or to modify the start time, click the Plus and

Minus icons.
d. In the End field, enter the end time or to modify the end time, click the Plus and Minus

icons.
7. To configure the update settings, complete the following steps:

a. Select the Concurrency.

Note:  To ensure optimum transfer speeds, only select a concurrency value greater
than 1 if you have a high-bandwidth connection.

b. Click Upgrade.

Note: • The Firmware Upgrade Report pane displays the upgrade progress.• The
VideoEdge can reboot multiple times as part of the same upgrade action.• After the
upgrade is complete, the upgrade package is deleted from the VideoEdge.

Incremental updates

Updating the VideoEdge software through Incremental updates (victor 5.3+)
Before you begin:  

Note:
• Review the supported VideoEdge upgrade paths before you update your VideoEdge.
• If a recorder is eligible for a Push update and an Incremental update, you must use the

Incremental update.
• For more information about configuring Incremental updates, refer to the application note

Configuring Incremental Updates for victor 5.3.
• You can download the application note from the American Dynamics website.
• The Device Management page is not available in victor Express.

1. To install the update repository on the victor Application Server, complete the following steps:
a. Log on to the victor Application Server computer.

Note: You must log on to Windows with the same account that you used for the victor
installation.

b. Copy the Incremental Update Package onto the victor Application Server.
c. Unzip the update package contents.
d. Double-click the update package and follow the on-screen instructions to install the

update repository.
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2. Log on to victor Client.
3. Click the Settings icon, and Device Management
4. To add recorders to the Recorder Firmware tab, complete the following steps:

a. Click the Recorder Firmware tab.
b. Expand the Devices list and navigate to the recorders that you want to upgrade.
c. From the Devices list, drag the recorders into the Device Management window.

5. Select the recorders that you want to update.

Note: You cannot perform Push updates and Incremental updates as part of the same
operation. You cannot update different recorders to different versions as part of the
same action.

6. Optional: To schedule the firmware upgrade, complete the following steps:
a. Select the Schedule Firmware Upgrade check box.
b. In the Start field, enter the start date or to choose the start date, click the Calendar icon.
c. In the Start Time field, enter the start time or to modify the start time, click the Plus and

Minus icons.
d. In the End field, enter the end time or to modify the end time, click the Plus and Minus

icons.
7. To configure the update settings, complete the following steps:

a. Select the Concurrency.

Note: To ensure optimum transfer speeds, only select a concurrency value greater
than 1 if you have a high-bandwidth connection.

b. For VideoEdge 5.3+: To start transferring the firmware upgrade to the VideoEdge recorder,
select Transfer. When the transfer is complete, to start the firmware upgrade, select
Upgrade.

c. To perform a transfer and an upgrade as part of a single operation, select Upgrade.

Note:
- When you select the Upgrade option, the Transfer operation checks if a firmware

update file is already transferred to the VideoEdge, and it also checks if the
transferred file is up-to-date. If a newer firmware update is available, the updated
components are transferred before the upgrade begins.The Firmware Upgrade
Report pane displays the upgrade progress.

- The VideoEdge can reboot multiple times as part of the same upgrade action.
- When the upgrade is complete, the upgrade package is deleted from the VideoEdge.
- In victor 5.7, Transfer Required was moved to a later stage in the upgrade process

and is set to True.

Upgrading camera firmware and camera handler
firmware
VideoEdge users can upgrade camera firmware and camera handler firmware through the
VideoEdge Administration interface. Camera handler firmware is installed on the VideoEdge NVR
and it enhances the VideoEdge's compatibility with different camera models.Camera firmware is
installed on cameras and it enhances the functionality and their features.

About this task:  
Updating camera handler firmware
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1. Log on to the American Dynamics website.
2. From the main menu, click Support and Software Downloads.
3. Select Network Video Recorders, and select your VideoEdge model.
4. Check if a new handler is available for the cameras that you are using on your VideoEdge.
5. If an updated handler is available, download and upload to the VideoEdge.
6. For VideoEdge version 4.4 to 4.5:

a. From the VideoEdge Administration Interface, navigate to System &gt; Software Update.
b. To select the updated file, click Browse and Upload.
c. After the file uploads, select the handler and click Upgrade.

7. For VideoEdge version 4.5.1
a. From VideoEdge Administration Interface, navigate to System &gt; Software Update.
b. To select the updated file, click Choose File and Upload.
c. After the file uploads, select the handler and Install.

8. For VideoEdge version 4.6+
a. Use the softwareadmin user credential to log on to the NVR.
b. To select the updated file, click Browse and Upload.
c. After the file uploads, select the handler and click Install.

Updating camera firmware in VideoEdge
You can apply camera firmware updates for supported cameras through the VideoEdge
Administration Interface. The Update Camera Firmware page lists any supported cameras that
are connected to VideoEdge that are eligible for an update. To update camera firmware, you must
upload a new camera firmware package and then install the update. While a camera's firmware is
updating, a progress status displays to the right of the camera table.

About this task:  

Note: Firmware uploaded for a camera model is deleted and replaced with any firmware
subsequently uploaded for that same model. You can download firmware updates from the
American Dynamics website or from the camera manufacturer's website.

You can upgrade firmware for the following cameras.
• Illustra Pro Mini-done
• Illustra 625 PTZ
• Illustra Pro PTZ
• Illustra Pro Compact Mini-dome
• Illustra Pro Compact Mini-Bullet
• Illustra LT Bullet
• Illustra 2MP Micro
• Illustra 825 5MP Fisheye
• Illustra Flex 3MP &amp; 8MP (Flex2)

Note: These cameras must be connected to a VideoEdge 5.3+ recorder.

Downloading a camera firmware update file
1. Launch a web browser and go to www.americandynamics.net.
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2. Use your installer credentials to log on.
3. From the top navigation bar, select Support and Software Downloads.
4. Select a camera type, and select the camera model that you want to update.

Note: For some camera models, you must download the camera firmware files from the
Illustra website.

5. Navigate to the firmware version that you want to install.
6. Select the update method that you want to use:

a. To update the camera firmware through VideoEdge, select an update file that is
compatible with the VideoEdge Administration interface.

b. To update the camera firmware through victor's Device Management page, select
CameraFirmware.zip.

Note: You can also update camera firmware through the camera's web interface. For
more information, refer to the camera's documentation and firmware release notes.

7. Save the update file to a USB key.

Updating camera firmware

About this task:  

1. Use the softwareadmin credentials to log on.

Note: The default password for the softwareadmin user credential is softwareadmin.

2. Click the Update Camera Firmware tab.
3. Select the check box of the camera model you want to associate the firmware with.

Note: You can use the Filter Model list to filter the camera list. From the Filter Model list,
select a camera model to automatically select all cameras of that model type that are
eligible for a firmware update.

4. Click Choose a file.
5. Select the firmware package file and click Open. The name of the package file appears in the

Upload Camera Firmware field.
6. Optional: In the Optional SHA Checksum field, enter the checksum.
7. Click Upload. The uploaded package displays in the Firmware Package list.
8. Select the check box of the firmware package you want to apply.
9. Click Upgrade.

Deleting an uploaded firmware package
1. Use the softwareadmin credentials to log on.

Note: The default password for the softwareadmin user credential is softwareadmin.

2. Click the Update Camera Firmware tab.
3. Select the check box of the firmware package that you want to delete.
4. Click Delete
5. Click OK.
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Updating camera firmware in victor
In victor 5.3+, you can update camera firmware from the Device Management page.From the Device
Management page you can search for firmware updates for cameras that are connected to victor
client. If camera updates are available, you can import a list of eligible cameras to the camera
firmware menu. You can also schedule camera upgrades, to avoid taking a camera offline during a
busy surveillance period.

About this task:  
You can upgrade firmware for the following cameras.
• Illustra Pro Mini-done
• Illustra 625 PTZ
• Illustra Pro PTZ
• Illustra Pro Compact Mini-dome
• Illustra Pro Compact Mini-Bullet
• Illustra LT Bullet
• Illustra 2MP Micro
• Illustra 825 5MP Fisheye
• Illustra Flex 3MP &amp; 8MP (Flex2)

Note: These cameras must be connected to a VideoEdge 5.3+ recorder.

1. To install the update repository on the victor Application Server, complete the following steps:
a. Log on to the victor Application Server computer.

Note: You must log on to Windows with the same account that you used for the victor
installation.

b. Copy the firmware Update Package onto the victor Application Server.
c. Unzip the update package contents.
d. Double-click the update package and follow the on-screen instructions to install the

update repository.
2. Log on to victor Client.
3. Select the Settings icon and click Device Management.
4. To check for updates for all cameras from the Devices list, complete the following steps:

a. From the list, select Camera Firmware.
b. Click Find Upgrades.
c. If cameras are eligible for upgrade, to add the cameras to the Device Management page,

select Import results.
5. To check for updates for specific cameras

a. From the list, select Camera Firmware.
b. From the Devices list, drag cameras onto the Camera Firmware page. The page displays a

notification if a camera firmware update is available.
6. Optional: In the Release Notes column, select the icon to open a camera's firmware release

notes in your web browser.
7. Select the check boxes for devices that you want to upgrade.
8. Optional: To schedule the firmware upgrade, complete the following steps:

a. Select the Schedule Firmware Upgrade check box.
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b. In the Start field, enter the start date or to choose the start date, click the Calendar icon.
c. In the Start Time field, enter the start time or to modify the start time, click the Plus and

Minus icons.
d. In the End field, enter the end time or to modify the end time, click the Plus and Minus

icons.
9. To start the firmware upgrade, select Execute.

Note: The Firmware Upgrade Report pane displays the upgrade progress.

Applying a license to the VideoEdge
From VideoEdge version 4.9.0 onwards, there are two licensing options for VideoEdge: Local
licensing and Centralized licensing.

About this task:  
A Local license is stored locally on a VideoEdge. The VideoEdge upgrade procedure below details
how to apply a Local license.

Note:  In VideoEdge versions earlier than 5.1, Local licenses are called Permanent licenses in
the VideoEdge Licensing page.

A Centralized license is a victor license that contains both victor and VideoEdge features.
Centralized licenses are not stored on the VideoEdge - they are stored on a victor Application
Server. To access the Centralized license features, you must configure your VideoEdge to
connect to the victor Application Server. For more information on Centralized Licensing, refer
to the VideoEdge Installation and User Manual.

Note: The following steps apply to VideoEdge local licenses only. To upgrade to a Centralized
license, refer to the VideoEdge Installation and User Guide.

Updating a VideoEdge local license
1. Log on to the VideoEdge Administration Interface as an administrator.
2. To generate the Host ID, complete the following steps:

a. From the main menu, select System and Licensing.
b. Click Generate Host ID and save the XML file.

3. To update your license file, complete the following steps:
a. On a web browser, go to www.americandynamics.net, and log on with your installer

credentials.
b. From the top navigation bar, select Products and Register a Product.
c. On the Register a Product page, click VideoEdge Software.
d. From the Brand list, select American Dynamics and from the Product list, select VideoEdge.
e. Click Next.
f. Read the Personal Data Processing Consent information and click I consent and confirm.
g. In the Registration Type area, select Update Existing License.
h. In the License Version area, select the software version for your updated VideoEdge.
i. Complete the Integrator Information and End-User Information fields.
j. In the Software Details section, attach the Host ID file, enter your VideoEdge Software

Serial Number, and enter a comment if required.
k. Complete the Email Recipients fields.
l. Click Submit.
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Note: After you submit the registration form, if the information is valid, the license is
auto-generated and emailed to the license recipients.

4. To apply the software license, complete the following steps:
a. Save the license file onto the local PC.
b. From VideoEdge Administration Interface main menu, select System and Licensing.
c. From the Choose License Type list, select Local License.
d. In the Configure Local Licensing section, click Choose File.
e. Locate the license file and click Open.
f. Click Apply Local License. If it is a valid license for the VideoEdge Recorder, it accept it and

dynamically update the Licensing Status details.

Frequently asked questions: VideoEdge updates

Question: After an update, do I need to re-index my video data using the built-in re-indexer on
VideoEdge?
Answer: Re-indexing recorded media is not required after an update on the VideoEdge. Contact
Post-Sales Support before you run this tool.

Question: I re-imaged my VideoEdge recorder but I am unable to access any of my recorded video.
What should I do?
Answer: It is essential that you select the correct option when re-imaging your recorder in order to
preserve your video. If you wish to access video that was recorded with 4.3 software and you have
updated, contact Post Sales Technical support for a script which is required due to media database
changes that occurred in 4.4 onwards.

Question: I updated my VideoEdge recorder remotely using the web browser but it appears to be
stuck on a rebooting screen. What should I do?
Answer: When you update the VideoEdge using a remote desktop, during the reboot of the
VideoEdge after the install (a pop up message will appear to reboot the VideoEdge). If after 10
minutes the remote desktop web browser is still reporting a progress icon, refresh the Web
Browser.

Question: How can I protect my recorder from being vulnerable to the Bash bug- Shellshock?
Answer: GNU Bash Vulnerability: Bash bug – Shellshock. For VideoEdge Servers, this is only
required to be executed for Software versions 4.5.1 and earlier. Post 4.5.1 includes the critical patch
as part of the installation.

Question: I updated to a later version of software but I am unable to stream video. What should I
do?
Answer: After a VideoEdge update, if no video is streaming on victor/VideoEdge Client, a second
reboot of the server may be required to stream video due to a transmit manager delay caused
during the update. After this reboot the recorder streams as designed and this is only a one off
observed immediately following a reboot.

Question: Can I update from any version of VideoEdge to the latest version?
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Answer: No.
• For VideoEdge versions earlier than 4.4.4.122, you must update the VideoEdge to version

4.4.4.122 before you can update further.
• For VideoEdge versions earlier than 4.9.0.496, you must update the VideoEdge to version

4.9.0.496 before you can update further.
• To update to VideoEdge 4.9.1 or higher, you must update from VideoEdge 4.9.0.496 or higher.
• To update to VideoEdge 6.0.0 or higher, you must update from VideoEdge 5.7.0 or higher.
• For all VideoEdge versions except 4.9.0, you can update VideoEdge through an incremental

update, or manually through the Administration Interface. To update to VideoEdge 4.9.0, you
must use the VideoEdge Updater.

Question: Why can I not find 4.4.0.800 on the website?
Answer: This version of software has been replaced by 4.4.4.122, commonly referred to as 4.4 patch
4. This patch can be used in place of 4.4.0.800 when upgrading.

Question: I have tried to update my VideoEdge software and get a failure message. What should I
do?
Answer: Perform the following checks:
• Confirm that you are using the correct update software and are not using installation media.
• Ensure that there is sufficient space in the update repository. The simple way is to delete old

builds that are listed in uploaded packages on the software update web page of the recorder.
• If you are upgrading to VideoEdge version 4.9, make sure that you use the VideoEdge Updater.
• Ensure that you follow the correct update path.
• If the issue persists, contact Post-Sales Support.

Question: I cannot find the software update page after I upgrade my software. Has it moved?
Answer: Following the release of 4.6 and in an effort to improve security a new user was created
that was to be used for all updates, consult the documentation for details but this is the only
account that has the ability to update the VideoEdge software.

Compatibility matrices

Table 8: victor v 6.1 compatibility matrix (vMAS, vAS, vWC)
victor Interoperability (vMAS:victor
Enterprise, vAS: victor Application Server,
vWC: victor Web Client)

vMAS vAS vWC

AD victor Unified Client 6.1 6.1 n/a
Additional client
connections

Yes Yes n/a
Rich Thick Clients

Additional agent
connections

n/a Yes n/a

Rich Thin Clients AD victor Web Client n/a 6.0 6.1
Additional victor Web
Client connections

n/a Yes Yes

Mobile Client victor Go
IOS- App Store, Android
- Play Store

n/a 6.0 n/a
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Table 8: victor v 6.1 compatibility matrix (vMAS, vAS, vWC)
victor Interoperability (vMAS:victor
Enterprise, vAS: victor Application Server,
vWC: victor Web Client)

vMAS vAS vWC

VideoEdge Cameras n/a Yes n/a
VideoEdge
VideoAnalytics Channels

n/a Yes n/a

Videoedge Face
Recognition Channels

n/a Yes n/a

VideoEdge Face
Verification Channels

n/a Yes n/a

VideoEdge Licenses

VideoEdge Deep
Intelligence Analytics
Channels

n/a Yes n/a

AD VideoEdge NVR &
Micro

n/a 4.0 to 6.1 6.1

AD VideoEdge Hybrid
Appliance

n/a 4.2.1 to 6.1 6.1

AD Intellex DVR n/a Yes 6.1

Video

Holis NVR n/a Yes n/a
SWH C•CURE 9000
Unified

3.0 3.0 n/a

CEM n/a Yes n/a

Access

Kantech Entrapass
(Corporate Edit.)

n/a Yes n/a

BMS BACnet n/a Yes n/a
CMS Mastermind n/a Yes n/a
EAS LDM Sensornet n/a Yes n/a

Kone n/a Yes n/a
Otis n/a Yes n/a
Schindler n/a Yes n/a

Elevator

ThyssenKrupp n/a Yes n/a
Enterprise Application Server (MAS

and Standalone vAS
promoted to SAS)

Included Yes n/a

Simplex 4100U/ES n/a Yes n/aFire
MZX Technology n/a Yes n/a
Commend n/a Yes n/aIntercom
TOA (AiPhone) n/a Yes n/a
DSC Power Series n/a Yes n/a
DSC Neo ITV2 n/a Yes n/a
Sur-Gard n/a Yes n/a
Bosch Receiver n/a Yes n/a
DMP n/a Yes n/a

Intrusion

Galaxy n/a Yes n/a
POS Point-of Sale Support n/a Yes n/a
Protocol LDAP Yes Yes n/a
Real-Time Locator Elpas n/a Yes n/a
Web Service victor web Service n/a Yes n/a
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Table 8: victor v 6.1 compatibility matrix (vMAS, vAS, vWC)
victor Interoperability (vMAS:victor
Enterprise, vAS: victor Application Server,
vWC: victor Web Client)

vMAS vAS vWC

Analog Matrix n/a Yes n/a
De-warping n/a Yes n/a
Health Monitoring n/a Yes n/a
Incident Builder n/a Yes n/a
Maps n/a Yes n/a
Record on Surveillance n/a Yes n/a
Reporting Yes Yes n/a

victor Client

Virtual Matrix PTZ
Keyboard

n/a Yes n/a

Unified Feature Set
• Access Control

Device Setup
• Personnel
• Swipe and Show

n/a Yes Yes

Health Dashboard n/a Yes Yes

victor Web Client

Maps n/a Yes Yes

Table 9: VideoEdge 6.0 compatibility and configuration matrix (NVR, Hybrid, Micro)
VideoEdge Interoperability NVR/Hybrid/Micro SW:6.0.x

Unified victor/C•CURE 9000 5.7 and highervictor
victor Application Server/Site Manager
victor Express
victor Client

5.7 and higher

Local Client VideoEdge Local Client Yes
Thin Client victor Web LT Yes
Mobile Client VideoEdge GO (iOS - App Store) Yes

Motion Detection Complimentary
Licenses

Yes

VideoEdge Camera Licenses Yes
VideoEdge Video Intelligence Licenses Yes
VideoEdge Face Verification Licenses Yes
VideoEdge Face Recognition Licenses Yes
License Plate Recognition Licenses Yes
Deep Intelligence Licenses Yes

VideoEdge Options

Illustra Pro Complimentary Licenses Yes
VE Micro Appliance (4-port POE) YesVideoEdge Micro Configs
VE Micro Appliance (8-Port POE) (Note
Max 8Cam+1 VA)

Yes

VideoEdge 1U NVR VE 1U NVR (16-Port POE or 8-Port POE+)
VE NVR Bundled Server (Tower) n/a
VE NVR Bundled Server (Desktop)16 Tyco-Desktop

VE NVR Bundled Server (2U Rack)16 Tyco-2U
VE NVR Bundled Server (2URack with
Deep Intelligence

Tyco-2U

VE NVR Bundled Server (2U High Density
Rack)

PE-R730
PE-R740

VideoEdge NVR Configs

VE NVR Software Only Yes
Hybrid Maximum cameras (Analog Plus
IP)

"X" Analog + "Y" IP

VideoEdge Hybrid Models VE Hybrid Appliance (Desktop) (8+8) to (0+16)
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Table 9: VideoEdge 6.0 compatibility and configuration matrix (NVR, Hybrid, Micro)
VideoEdge Interoperability NVR/Hybrid/Micro SW:6.0.x

VE Hybrid Appliance (2U Rack) (16+16) to (0+32)
VE Hybrid Appliance (3U Rack) (32+32) to (0+64)

Table 10: victor application server (vAS) and C•CURE: victor client compatibility matrix 5.0 to
6.1
vAS C•CURE 5.0 5.1 5.2 5.3 5.4 5.4.1 5.6 5.7 5.9 6.0 6.1
5.0 2.61 S C C - - - - - - - -
5.1 2.61 C S C C - - - - - - -
5.2 2.7 C C S C C C - - - - -
5.3 n/a - C C S C C C - - - -
5.4 n/a - - C C S C C C - - -
5.4.1 2.8 - - C C C S C C C - -
5.6 2.9 - - C C C C S C C C -
5.7 2.9 - - C C C C C S C C C
5.9 2.9 - - C C C C C C S C C
6.0 3.0 - - - - - - C C C S C
6.1 - - - - - - - - C C C S

Note: S=Supported C=Core functionality only -=Not supported

Table 11: victor Application Server: VideoEdge recorder compatibility matrix 5.0 to 6.1
vAS 5.0 5.1 5.2 5.3 5.4 5.4.1 5.6 5.7 5.9 6.0 6.1
5.0 S C C C C C C C C C C
5.1 S S C C C C C C C C C
5.2 S S S C C C C C C C C
5.3 S S S S C C C C C C C
5.4 S S S S S S C C C C C
5.4.1 S S S S S S C C C C C
5.6 S S S S S S S C C C C
5.7 S S S S S S S S C C C
5.9 S S S S S S S S S C C
6.0 S S S S S S S S S S C
6.1 S S S S S S S S S S S

Note: S=Supported C=Core functionality only -=Not supported

Table 12: victor application server: recorder compatibility matrix
vAS Intellex 3.2-5.02 AD HDVR 1.5-2.4 Exacq HDVR 5.0-22.0 TVR 2.22-2.60.04
5.0 S S S S
5.1 S S S S
5.2 S S S S
5.3 S S S S
5.4 S S S S
5.4.1 S S S S
5.6 S S S -
5.7 S S S -
5.9 S S S -
6.0 S S S -
6.1 S S S -

Note: S=Supported C=Core functionality only -=Not supported
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Table 13: VideoEdge hardware and software compatibility matrix
VideoEdge
Hardware

4.5.
1

4.6 4.7 4.7.
1

4.8 4.8
SP1

4.8.
1

4.9 4.9.
1

4.9.
2

5.0 5.1 5.2 5.2.
2

5.3 5.4 5.4.
1

5.6 5.7 5.9 6.0 6.1

1U NVR with
PoE Haswell

- - - - - - - - - S S S S S S S S S S S - -

1U NVR with
PoE Skylake

- - - - - - - - - - - - - - S S S S S S S S

Desktop Hybrid/
IP only Sandy
Bridge

S S S S S S S S S S S S S S S S S - - - - -

Desktop Hybrid/
IP only Haswell

S S S S S S S S S S S S S S S S S S S S - -

Desktop Hybrid/
IP only Skylake

- - - - - - - - - - S S S S S S S S S S S S

2U/3U Hybrid,
2U IP Sandy
Bridge

S S S S S S S S S S S S S S S S S - - - - -

2U/3U Hybrid,
2U IP Haswell

S S S S S S S S S S S S S S S S S S S S - -

2U/3U Hybrid
2U IP Skylake

- - - - - - - - - - S S S S S S S S S S - -

2U/3U Hybrid,
2U IP Aaeon

- - - - - - - - - - - - - - S S S S S S S S

Micro NVR S S S S S S S S S S S S S S S S S S S S S S
Dell R710 S S S S S S S S S S S S S S - - - - - - - -
Dell R720 S S S S S S S S S S S S S S S S S - - - - -
Dell R730 S S S S S S S S S S S S S S S S S S S S S S
Dell R740 - - - - - - - - - - - - - S S S S S S S S S
Tyco Analytics
Appliance/NUC

- - - - - - - - - - - - - - S S S S S S S S

Tyco
Transcoder/
NUC

- - - - - - - - - - - - - - S S S S S S S S

Note: S=Supported C=Core functionality only -=Not supported

Contact information
If you have any questions, please contact American Dynamics Technical Services.
Contact details for your region can be found at https://support.americandynamics.net/#/contact
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